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Sequence of Programming Steps for PartMaker-EDM 

Note: If you already have entered the required tools and cycles for a job proceed to step 3. 

1. Choose the Tools command from the ToolMinder menu to add new wires. 

2. Choose the Cycles command from the ToolMinder menu to add new cycles.  

3. Choose the Open Material File command from the File menu to load the materials file. 

4. Choose the Defaults command from the Job Optimizer menu to set up your defaults. 

5. Choose the Setup command from the View menu to specify part boundaries and choose a 
wire.  

6. Create geometry in CAD mode or choose the Import button from the tool bar if you want to 
import geometry from a .dxf file or a solid model.  

7. Switch back to CAM Mode clicking the CAD/CAM switch. 

The CAD/CAM switch appears as 
 

in CAM Mode and as 
 

in CAD Mode 

8. Choose the New Profile Group command from the Part Features menu to add a new profile 
group. 

   

9. Create profiles using the following icons:  

 
Profile Icon 

 
Chain Geometry  2 Point Chain  

10. Set approach and escape points by double clicking on a tool path with the Selection icon. 

11. Modify burning strategies and tapers using the Profile Info Dialog icon  

12. Repeat steps 8 through 11 to create groups of all part features required for the job.  

13. Choose the Open Post Configuration File command from the Job Optimizer menu and 
select the desired post processor for your Wire EDM machine.  

14. Choose the Generate Process Table command from the Job Optimizer menu to generate a 
process table.  

15. Choose Simulation from the main tool bar to watch the part the cut in 3D.  

16. Choose the Generate NC Program command from the Job Optimizer menu to generate an 
NC Program.  
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Important User Notices  
 
Copyright 1991-2014 Delcam Ltd. All rights reserved.  
 
Delcam Ltd has no control over the use made of the software described in this 
manual and cannot accept responsibility for any loss or damage howsoever 
caused as a result of using the software. Users are advised that all the results 
from the software should be checked by a competent person, in accordance 
with good quality control procedures.  
 
The functionality and user interface in this manual is subject to change without 
notice in future revisions of software.  
 
The software described in this manual is furnished under licence agreement and 
may be used or copied solely in accordance with the terms of such licence.  
Delcam Ltd grants permission for licensed users to print copies of this manual or 
portions of this manual for personal use only. Schools, colleges and universities 
that are licensed to use the software may make copies of this manual or 
portions of this manual for students currently registered for classes where the 
software is used.  
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Chapter 1: Getting Started with 
PartMaker 
In Your Package  

 PartMaker CD-ROMs 

 PartMaker Manuals 

 Hardware lock 

Separately, if you have a stand-alone license of PartMaker, you will receive a 
Product Authorization File (PAF). 

Technical Support 
Please use the following information when you wish to get Technical Support or 
more information about PartMaker’s products: 

Phone:  215-643-5077 

Fax:   215-653-0105  

e-mail:  support@partmaker.com  

Web Site:  http://www.PartMaker.com 

A Customer PIN has also come included with your PartMaker software.  
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Before Using PartMaker... 
Before you begin working with PartMaker, you need a basic knowledge of Microsoft 
Windows operations. You should understand mouse techniques such as pointing, 
clicking, double clicking, dragging, choosing menu commands, and making dialog 
selections. If you are unfamiliar with basic Microsoft Windows terms or techniques, 
see your Microsoft Windows documentation for details. 

System Requirements 
Please read the following sections to determine what you’ll need to get started with 
PartMaker. To use PartMaker, you need a Windows-based PC with the following 
specifications: 

 
PartMaker 
Standard 

Parasolid 
Import Module 

(Solids)* 

Full Machine 
Simulation 

(FMS) 

Advanced 
Surface 

Machining (ASM) 

Processor Pentium 3 800 
MHz or higher 

Pentium 3 800 
MHz or higher 

Pentium 4 3 
GHz or higher 

Intel Core Duo 
processor or higher 

Memory 512 MB or more 1 GB or more 2 GB or more 4 GB or more 

Hard drive 40 GB 40 GB 40 GB 80 GB 

Independent 
video card 128 MB NVIDIA 512 MB NVIDIA 512 MB 

NVIDIA 1 GB NVIDIA 

 

64-bit and 32-bit versions of PartMaker are available and are supported on Windows 
7. Only the 64-bit version of PartMaker is compatible with Windows 8 PCs. 

Please take note that Microsoft has discontinued support for the Windows XP and 
Vista operating systems. 
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Starting PartMaker 
From your desktop, double-click the PartMaker WireEDM icon. 

A window containing information about PartMaker appears for a few moments. 

 
The PartMaker application window and the Setup dialog are displayed in the Face 
Window. 
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Exiting PartMaker 
1 To exit PartMaker, choose Exit from the File menu. 

If you changed an open job file, a dialog prompts you to save the current job 
file before exiting. 

 
2 Do one of the following: 

 Click <Yes> to save the changes. 

 If the file is untitled, select a location and enter a file name in the dialog 
that appears, then click <OK>. 

 Click <No> to discard the changes and exit. 

 Click <Cancel> to return to the presentation window without exiting. 

Using On-Line Help 
On-line help provides fast access to information about the application’s tools, 
commands, dialogs, and program features. Help commands are located in the Help 
menu in PartMaker: 

1 Choose Help Topics from the PartMaker Help menu or press <F1>. 

The Help window appears, displaying the Main Index. 

 
2 Click an index to view a list of help topics. 
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3 Click the topic you want to read about. 

Information about the selected topic appears in the window. 

 Note: Some topic lists include sub-lists from which you can select a help 
topic. 

4 To return to the last screen you viewed, click the <Back> button. 

5 To search for information, click the <Search> button. 

6 Type in a key word to choose a topic and click the <List Topics> button. 

7 Click the <Display> button to view the selected topic.  Your help screen will 
appear as below: 

 
8 When you are finished using help, choose Close from the help window’s 

Control menu. 

Using Context-Sensitive Help 
To view context-sensitive help while viewing any PartMaker dialog: 

1 Display any PartMaker dialog. 

2 Press <F1> to display the help topic for the dialog. 
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Installing Updates 
PartMaker Version 2010 and higher allows you to update to more recent versions 
and service packs of the software automatically from the PartMaker environment. 
You can check for and download the most recent version of PartMaker by selecting 
Check for PartMaker Updates from the Help menu. 

Working with Databases 
Databases are where you store tool, material, and cycle information for 
PartMaker jobs. PartMaker uses material, tools, and cycles databases to store the 
information needed for each job. 

Material Database 
A Materials Database allows you to store your shop’s accumulated materials 
data. Materials data is used by PartMaker in the automatic calculation of 
feedrates and spindle speeds. In addition, you can utilize material data in the 
extensive material library provided with PartMaker. 

Turn to Appendix A for a complete list of materials. 

Tools (Wire) Database 
A Tools Database allows you to keep track of your current wire inventory. 
PartMaker uses geometric and wire characteristics saved with each tool in the 
database for automatic cutting conditions. 

Cycles Database 
PartMaker lets you combine a number of repetitive operations (center drilling, 
drilling, tapping, boring, etc.) into a single entity called a Cycle.  All cycles are 
saved in a Cycles Database. For each cycle operation, you can designate a tool 
from the Tools Database. Once a cycle is created, you can recall it at any time 
when you need to use it again. 

Working With Files 
PartMaker uses several kinds of files for storing tools, cycles, and material 
information as well as your jobs and the postprocessor files used to create NC 
programs for machining. 

 Information about wires in the tool crib is saved in Tools files that have the 
file extension .TDE. 

 Information about material characteristics needed to calculate machining 
strategies is saved in Material files that have the file extension .MDE. 

 Information about user-created machining cycles is saved in Cycles files that 
have the file extension .CDE . 

 Part geometry is saved in Job files that have the file extension .JBE. 

 Postprocessor configuration information is saved in Post Configuration files 
that have the file extension .PST. 

 Note: In PartMaker Wire EDM, notice that the Tools, Materials, Cycles and Job 
files all end with an e.  This distinguishes Wire EDM files from files use in 
other PartMaker applications. 
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Chapter 2: PartMaker Fundamentals 
Introduction 

This chapter provides an overview of the PartMaker environment. You will learn 
basic concepts such as how to work in a face window to define part geometry in 
CAD Mode and locations of profiles and other icons in CAM mode.  Also, this chapter 
will describe how to apply PartMaker’s knowledge-based approach to programming 
Wire EDM. 

Tools (Wire) Database 
A Tools Database allows you to keep track of your current wire inventory. PartMaker 
uses geometric and wire characteristics saved with each tool in the database for 
automatic cutting conditions. 

Working with the Tools Database in PartMaker Wire EDM 
You can access the Tools Database by choosing Tools from the ToolMinder 
menu.  

When doing so you should see the dialog shown below: 

 
1 Diameter represents the wire diameter being used 

2 Time Factor allows the user to incorporate the adaptive feed rate control 
provided by some EDM controls in the time calculation displayed on 
PartMaker’s Process Table. 

3 This list specifies the current wire inventory stored in the Tools Database.  
The wires specified here are available for selection from the Setup dialog 
when starting PartMaker. 
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4 Clicking these function buttons with the left hand mouse button does the 
following: 

<New> - Allows you to add additional wires to the Tools database. 

<Delete> - Allows you to remove or delete an existing tool from the tools 
database. 

<Close> - Accepts the changes you have made and closes the dialog. 

<Apply> - Applies the changes you have made and leaves the dialog open. 

Material Database 
A Materials Database allows you to store your shop’s accumulated materials data. 
Materials data is used by PartMaker in the automatic creation of burning 
strategies. In addition, you can utilize material data in the extensive material library 
provided with PartMaker. 

Working with the Material Database in PartMaker Wire EDM 
You can access the Materials Database by choosing Material from the 
ToolMinder menu.  

When doing so you should see the dialog shown below: 

 
Wire represents the wire diameter as specified in the Tools Database for which 
the materials listed are available 

The list of Materials represents the current inventory of materials available for 
the given the wire selected. 

These fields specify the following information for a given material: 

Name – Specifies the name of the designated material. 

Thickness – Specifies the initial thickness of the designated material. 

Taper - Specifies the taper of the cut for a given material.  You may have a 
number of the same materials each specified with a different taper.  This is 
important because various taper sizes will warrant different burning 
strategies and power settings. 
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Cycles Database 
PartMaker lets you combine a number of repetitive operations (start up, rough 
cutting, finish cutting, etc.) into a single entity called a Cycle.  All cycles are saved 
in a Cycles Database. Once a cycle is created, you can recall it at any time when 
you need to use it again.  

Working with the Cycles Database in PartMaker Wire EDM 
Cycles may only be added once the appropriate Wires and Materials have been 
created in the Tools and Materials Databases respectively.  

You can access the Cycles Database by choosing Cycles from the ToolMinder 
menu.  

When doing so you should see the dialog shown below: 

 
1 These fields allow you to set the Power Setting, Offset, recommended 

Feedrate, Upper Flow, Lower Flow and Taper Angle for the Safe 
Startup, Rough Cut and each Skim Cut being defined for a given Cycle. 

2 Specifies the wire from the Tools Database being used in the cycles. 

3 Specifies the material from the Material Library being used in the current 
cycle. 

4 Specifies the number of Skim Cuts being taken in this cycle. 

5 Clicking these function buttons with the left hand mouse button does the 
following: 

<New> - Allows you to add an additional Cycle to the Cycles database. 

<Delete> - Allows you to remove or delete an existing Cycles from the 
Cycles database. 

<Close> - Accepts the changes you have made and closes the dialog. 

<Apply> - Applies the changes you have made and leaves the dialog open. 
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6 The <Retrieve Cycle> button allows you to select a cycle from an existing 
library of cycles created for a specific machine.  Your PartMaker Wire EDM 
software comes with one such file standard as configured for a Mitsubishi FX-
20 Wire EDM. 

7 The List of Cycles  text box lists all of the cycles currently stored in the 
Cycles database. 

Below, find instruction for adding Cycles to the Cycles Database. 

Adding Cycles to the Cycles Database in PartMaker Wire EDM 
Cycles may be added to the Cycles Databases either by creating them one by 
one with advice of your Wire EDM manual or selecting them from a preexisting 
library of cycles for your machine.  Most commonly you will be creating these 
cycles, though you can consult PartMaker Inc. or your authorized PartMaker 
reseller for more information on obtaining a preexisting library of cycles for your 
machine. 

Method 1: Adding Cycles Individually 
To create cycles individually, it is recommended you refer to the power 
recommendations that came with your Wire EDM’s operations and/or 
programming manual. 

On the page that follows, such information as taken from a Mitsubishi FX-20 
Model Wire EDM (inches) has been inserted.  Based upon this information, a 
typical inch cycle will be created. 
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  Mitsubishi  
  FX Submerged Extended View Data Sheet  
           

  
Wire Diameter 

and Type Material Type Process Material Thickness  
  .004 hard brass Carbide ST 0.25  
           
           
  Cutting Process Start-Up Rough Cut Skim 1 Skim 2 Skim 3 Skim 4 Skim 5  
  E-pack Number 5210 5211 5212 5213 5214 5215 5216  
  Voltage Open 14 14 4 3 4 3 4  
  Power Setting 4 4 4 4 3 3 1  
  Off Time 1 1 1 1 10 10 4  
  Stabilizer A 1 2 1 1 2 2 2  
  Stabilizer B 16 14 16 14 8 8 3  
  Wire Speed 12 14 14 12 12 12 12  
  Wire Tension 3 3 4 4 4 4 4  
  Pre-Tension 4 6 8 8 8 8 8  
  Liquid Quantity 2 2 1 1 1 1 1  
  Liquid Resistivity 7 7 7 7 7 7 7  
  Voltage Gap 56 46 46 50 65 60 35  
  Stabilizer C 1 1 1 1 1 1 1  
  AE Mode 21 21 21 21 11 11 11  
  Stabilizer E 1 2 1 1 1 1 1  
  Feedrate Address 0.015 0.035 0.1 0.09 0.14 0.14 0.14  
           
  Offset Value(s) --------- 1 2 3 4 5 6  
  Rough Cut --------- 0.00300 --------- --------- --------- --------- ---------  
  Rough & 1 Skim --------- 0.00450 0.00250 --------- --------- --------- ---------  
  Rough & 2 Skims --------- 0.00540 0.00340 0.00240 --------- --------- ---------  
  Rough & 3 Skims --------- 0.00570 0.00370 0.00270 0.00230 --------- ---------  
  Rough & 4 Skims --------- 0.00590 0.00390 0.00290 0.00250 0.00230 ---------  
  Rough & 5 Skims --------- 0.00600 0.00400 0.00300 0.00260 0.00240 0.00250  
  Stepping Increment --------- --------- 0.00100 --------- --------- --------- ---------  
  Upper Flow Rate 4.0 4.0 1.0 1.0 1.0 1.0 1.0  
  Lower Flow Rate 4.0 4.0 1.0 1.0 1.0 1.0 1.0  
                   



 

2-6 PartMaker  Copyright @2014 Delcam Ltd 

 

Method 1: Adding Cycles Individually (cont’d) 
Referring to the information provided on the previous page, we will create a 
cycle for .250 inch thick carbide using 2 skim cuts with a .004 inch diameter 
wire. To do so: 

1 Click the <New> button to create a new cycle that appears in the list of 
cycles as Untitled 4. 

2 From the Wire drop down menu, choose Brass .004 

3 Click the Part Material button and you will be prompted with dialog below: 

 
4 From the list of Materials, choose Carbide 0.250 and click the <OK> button 

5 From the # of Skim Cuts drop down menu, choose 2. At this point, your 
cycles dialog should appear as shown below: 
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6 Now, complete the Cycles page based upon the information provided on 
previous page.  The relevant data you will enter is as follows: 

 Power 
Setting

Offset Feed 
Rate 

Upper 
Flow 

Lower 
Flow 

Taper 
Angle 

Safe 
Startup 

5210  .015   N/A 

Rough Cut 5211 .00540 .035 4.0 4.0 N/A 

Skim Cut 1 5212 .00570 .100 1.0 1.0 N/A 

Skim Cut 2 5213 .00590 .090 1.0 1.0 N/A 

Make sure you understand where these values originated. 

7 Once you entered the values in the table above, type 2_Carbide_0.250 in the 
Rename to: field, and click the <Apply> button.  Your completed cycles 
dialog should appear as shown below: 
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Method 2: Adding Cycles using the Retrieve Cycle Button 
In certain cases PartMaker comes preloaded with Cycles for specific machine.  
These cycles can be accessed using the Retrieve Cycle button.   

 Important! Before moving on, please be certain that cycles for your exact 
model of Wire EDM have been created.   

To retrieve the same Cycle created above from library for your machine: 

1 Click the <Retrieve Cycle> button.  After doing so, you will be prompted 
with Wire and Part Data dialog shown below: 

 
2 From the Wire drop down menu, choose Brass .004 

3 Click the Part Material button and you will be prompted with dialog below: 

 
4 From the list of Materials, choose Carbide 0.250 and click the <OK> button 

5 From the # of Skim Cuts drop down menu, choose 2. 
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At this point, your Wire and Part Data dialog should appear as shown below: 

 
6 Click the retrieve button and your cycle will be retrieved from the master 

cycles database for your Wire EDM.  Your completed cycles dialog should 
appear as shown below: 

 
In Chapter 3, Creating a Sample Part, you will learn more about how to apply the 
uses of cycles to various burning strategies to create paths for the wire. 
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Working in a Face Window 
A Face Window is the work area in which you define groups of holes and profiles 
that need to be machined. The main area of the window displays the part 
boundaries; the left side displays group icons, which have cycle name labels needed 
to machine the current part. 

 
 

 
Displaying the Axes Choose Show Axes from the 

View menu. 

 Displaying the Grid Choose Show Grid from the 
View menu. 

 
Displaying the Boundaries Choose Show Boundaries from 

the View menu. 
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Using the CAD/CAM Switch 

 
This icon represents CAM mode. Clicking it will switch the program to the CAD mode. 

 

All tool path creation and process development is done in the CAM mode. All 
geometry creation and alteration is done in the CAD mode. 

Using the Color Bar 

 
You use the color bar in the upper-right corner of a Face Window to select a color 
for group symbols. You can also use it to change the color of geometry. The group 
symbol or geometric element will have the color of the currently chosen Sample 
Color. 

 Note: If you want to change the color of a Group Symbol, select the Group 
Symbol in the Face Window, click a color on the color bar, and then click 
the Sample Color on the left side of the color bar. 

To change the color of a geometric element, select the geometry in the Face 
Window, click a color on the color bar, and then click the Sample Color on the left 
side of the color bar. 

Using the Icon Toolbars 
PartMaker Version 9 and higher provides Toolbars to speed up commonly used 
functions throughout the software. PartMaker supports four types of icon toolbars, a 
Main Toolbar which is available throughout a job file, a Face Window Toolbar 
which is associated with each Face Window, a Solids Window Toolbar which 
appears when working with an imported Solid Model and a Simulation Toolbar 
which appears when working in PartMaker’s 3D simulation.  Here, the Main Toolbar 
and Face Window Toolbar are explained.  Chapter 6 of this guide will explain the 
use of the Simulation Toolbar while Appendix C to this manual will explain the use of 
the Solids Window Toolbar. 
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Main Toolbar 
The Main Toolbar lets you perform many of the functions in PartMaker’s menus 
with the click of a button.  The Main Toolbar will look the same throughout your 
PartMaker session and appears as below: 

 

 Note:  When holding your mouse over any of these icons, a “Tool Tip” will 
appear showing the function performed by that icon. Each command is 
explained in greater detail in Chapter 4 of this manual. 

Face Window Toolbar – CAM Mode 
The Face Window Toolbar lets you perform many of the functions in PartMaker’s 
menu’s with the click of a button.  The Face Window Toolbar applies only to the 
active Face Window and may look differently depending on the Machining 
Function Face Window being used. 

 

Face Window Toolbar – CAD Mode 

 

Displaying Toolbar Icons 
The display of the Toolbars can be manipulated by choosing Toolbars from the 
View menu.  When a toolbar is checked, it will appear.  When unchecked, it will not 
be visible.   
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Creating Groups of Part Features 
Groups of part features such as holes and profiles are created in PartMaker. The 
currently selected group icon or Group Symbol in a Face Window is the work 
group from which tool paths are being added. 

To create a new Group Symbol: 

1 Click the desired color on the color bar.  

2 Choose New Profile from the Part Features menu to display the Group 
Parameters dialog. 

When you exit the dialog, the new group is created using the color you 
specified. 

 
 

Using the Graphics Icons in PartMaker CAD mode 
You can create your part drawings in PartMaker in the CAD mode. Alternatively, 
you also import drawings from other CAD systems into PartMaker by using the 
Import command from the File menu. Imported geometry can be altered in 
PartMaker’s CAD mode. 

 
Geometry is created in PartMaker CAD using the Graphics Icons that include 
Drawing Icons and Snap Modes. 
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Geometry Drawing Icons 
Geometry Drawing icons allow you to create different types of geometric 
constructions such as lines and arcs. PartMaker’s geometry drawing icons are 
defined below. 

 

Selection Icon indicates that the system is in the selection mode. In this 
mode you can select lines, arcs and circles in the Face Window either by 
clicking on them or dragging a selection rectangle around them. 

 
Zero Icon allows you to define a new location for the zero point using 
Snap Modes. 

 
Trim/Extend Icon allows you to stretch or shorten an existing line or arc. 

 
Remove Icon allows you to remove portions of lines or arcs between 
intersection points. 

 
Line Thru Two Points Icon allows you to create a line between two 
points specified using Snap Modes. 

 
Connected Lines Icon allows you to create connected lines with end 
points specified using Snap Modes. 

 
Line Parallel Horizontal axis Icon  allows you to create a line parallel to 
the Horizontal axis by specifying positive or negative offset. 

 
Line Parallel Vertical axis Icon  allows you to create a line parallel to 
the Vertical axis by specifying positive or negative offset. 

 
Parallel Element Icon allows you to create a line, arc, or circle parallel to 
the cursor selected entity specifying an unsigned distance. 

 
Line on an Angle Icon allows you to create a line on an angle to a cursor-
selected line passing through a point specified using Snap Modes. 

 
Fillet Icon allows you to insert a fillet between two cursor-selected lines or 
arcs. 

 
Chamfer Icon allows you to insert a chamfer between two cursor-selected 
lines or arcs. 

 
Circle with a Known Radius and Center Icon allows you to define a 
circle with a center specified using Snap Modes. 

 
Circle with a Known Radius and Two Points Icon allows you to define 
a circle with two points on the circumference specified using Snap Modes. 

 

Circle with a Known Center and a Point Icon allows you to define a 
circle with a center and a point on the circumference specified using Snap 
Modes. 

 
Circle Through Three Points Icon allows you to define a circle with three 
points specified using Snap Modes. 

 
Polygon Icon allows you to create a various rectangles by entering a flat-
to-flat distance. 

 
Divide/Append Icon aids you in the “breaking” of segments at specific 
point within the geometry. 

 
Multiple Offset Icon allows you to offset the selected geometry chain 
through a user-defined distance. 

 
Ellipse Icon allows you to create an approximate ellipse in the face 
window, using tangential circular arcs. 
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Dimensioning Icons 
The Dimensioning Icons appear in the PartMaker CAD mode.  These icons allow you 
to create dimension and annotations on your drawings in PartMaker. 

 

 
Note Icon Allows you to create a note on a dimensioned drawing. 

 
Note with Leader Icon allows you create a note with an arrow leader to 
point to a specific item on your drawing you wish to annotate. 

 
Angular Dimension  This icon allows you to insert an Angular Dimension 
between two lines.. 

 
Circular Dimension Icon This icon allows you to insert a Circular 
Dimension on arc or circle. 

 

Horizontal Dimension Icon This icon allows you to insert a Horizontal 
Dimension between two points that are either end points of arcs and lines 
or centers of circles. 

 

Vertical Dimension Icon This icon allows you to insert a Vertical 
Dimension between two points that are either end points of arcs and lines 
or centers of circles. 

 

Linear Dimension Icon This icon allows you to insert a Linear Dimension 
between two points that are either end points of arcs and lines or centers 
of circles. 

 

Flexible Dimension Icon This icon allows you to insert a “Flexible 
Dimension” that is automatically set by the software to either Horizontal 
Dimension or Vertical Dimension or Linear Dimension depending on the 
cursor position when the text location is specified. 
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Snap Modes 
Snap modes are used in conjunction with geometry icons to define point location. 
PartMaker’s Snap Modes are defined below. Snap drawing modes are also used in 
the CAM mode to define tool path location. 

 

 XY Coordinates: Used for entering Cartesian coordinates. 

 Polar Coordinates: Used for entering Polar coordinates 

 
Point on a Circle: Clicking a point on an existing arc or circle and entering 
an Angle 

 Screen: Clicking a cursor location anywhere within the face window 

 
Grid: Clicking a grid location (grid can be turned on from the View Menu by 
choosing Show Grid. Grid size can be set in the Preferences dialog accessed 
from the View menu). 

 Circle Center: Clicking the center an existing circle 

 
Closest Intersection: Clicking the closest intersection of geometric 
elements 

 End of an Element: Clicking the end of an existing line or arc 

 Middle of an Element: Clicking the middle of an existing line or arc 

 
Tangency: Clicking near the tangency point that will be calculated by the 
system 

 
Horizontal Constraint allows you to specify a point whose vertical 
coordinate remains constant, allowing changes in horizontal coordinate only. 

 
Vertical Constraint allows you to specify a point whose horizontal 
coordinate remains constant, allowing changes in vertical coordinate only. 
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Using the Graphics Icons in PartMaker CAM mode 
The Graphics Icons on the left side of a CAM Face Window allow you to define and 
manipulate tool paths. Certain Graphics Icons for use in assigning a particular part 
feature to your part (i.e. a Group Symbol) will have a different appearance and 
function depending on the Machining Function Face Window being used. 
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The two icons below will have the same appearance and usage regardless of which 
machining function Face Window you are using. 

 

Selection Icon indicates that the system is in the selection mode. 
In this mode, you can select part features and tool paths in the 
Face Window either by clicking or dragging a selection rectangle 
around them. 

 

Selected profiles in a Face Window are highlighted; unselected 
profiles are not highlighted. Selected holes in a Face Window are 
highlighted; unselected holes are hollow.  You can delete selected 
elements by pressing the <Backspace> key on the keyboard or by 
choosing the Delete command from the Edit menu. 

 
Zero Icon allows you to define a new location for the zero point or 
origin using Snap Modes. 

Graphics icons on the left side of a face window allow you to define shapes for 
the EDM tool path.  

 

Profile Icon enables you to specify that the currently active group 
symbol is to be applied to the profile described by either coordinate 
entry or by clicking on geometric elements.  

 
 

Chain Icon enables you to specify that the currently active group 
symbol is to be applied to a profile that is created when PartMaker 
automatically connects all the elements that form an unbroken 
chain when an initial line or arc is clicked. 

 

2-Point Chain icon The 2-Point Chain icon allows you to define a 
profile by the start point in the chain, and the end point of the 
chain. 

 

Profile Info enables you to customize the properties of all or part 
of a tool path including changing a federate, offset, and adding text 
to individual finishing profile lines in contouring. 

 



 

Copyright @2014 Delcam Ltd  User Guide 3-1  

 

Chapter 3: PartMaker WireEDM Tutorial 
Introduction 

The print on the following page represents a part that may be made on a Wire EDM. 
The name of this part is EDM_DEMO. You’ll create the EDM_DEMO part in this 
chapter using PartMaker. 

This tutorial is designed to help you learn some of the most common PartMaker 
commands and features you will use every day. Before you begin, we recommend 
you read Chapter 2 if you have not already done so to familiarize yourself with 
some basic PartMaker concepts and features.  

 Important! The tutorial below is presented in both inch and metric units, 
depending on how you are working with PartMaker.  The inch units of 
measure are given first, with the metric entries gives in parenthesis ( ). 

For example you may see instruction that says: Enter an X value 1 (25), 
where 1 is 1 inch and 25 is 25 mm. 

How you will Create EDM_DEMO 
Here are the major steps you’ll follow to create EDM_DEMO: 

 Start PartMaker and open a new Face Window 

 Specify part boundaries 

 View tool information for the part 

 View cycle information for the part 

 Select a material for the part 

 Set up PartMaker defaults 

 Create Geometry  

 Define profiles for Inside Curves 

 Define profiles for Tapered circle 

 Define profiles for Outside curves 

 Select a post processor 

 Generate a process table containing burning data 

 Simulate burning of the part 

 Generate an NC program for the part 

 Print the NC program for the part 
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Inch Units 

 
 

Metric Units 

 
Finished Part 
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Getting Started 
The components of the completed tutorial part can be found in your PartMaker EDM 
directory under the following file names: 

Completed Job File:  C:\PartMaker\PM-EDM\edm_demo.JBE 

Completed Tools Data Base: C:\PartMaker\PM-EDM\edm_demo.TDE 

Completed Cycles Data Base: C:\PartMaker\PM-EDM\edm_demo.CDE 

EDM_DEMO has four groups of profiles to be burned. Each group has a cycle that 
records the burning strategies of each feature. Operations are shown for each group 
that is used for burning the part. 

You may find it useful to refer to the print on the previous page as you create 
EDM_DEMO. We have provided the finished part.  

Start PartMaker WireEDM 
1 In the Windows Start button, locate the PartMaker Group and click the 

PartMaker EDM application icon or just double click the WireEDM on your 
Windows desktop.  

2 PartMaker will open and by default the Setup window will be open. 

 
A Face Window is the work area in which you define geometry and part features. 
The main area of a Face Window displays the part boundaries; the left side of the 
window is used to display group icons, which show the cycles for machining a part. 

 Note:  If a dialog or window obscures the Face Window at any time during 
the tutorial, you can make the Face Window active again by clicking its title 
bar. 
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Set Up Part Boundaries 
1 To access the Setup dialog choose Setup from the View menu or click the 

Shortcut to the Setup Dialog Icon in the upper left hand corner of the Face 
Window.  The Setup dialog (inch) appears on top of the Face Window. 

 

 Tip: To advance from one numeric entry field to another in a dialog, press 
the <Tab> key. You can also press the <Tab> key to advance from the X 
coordinate field to the Y coordinate field when a numeric prompt appears at 
the bottom of a Face Window. 

2 Enter the following values next to these options in the dialog. Metric dimensions 
shown (metric): 

Part Height (H) 1.0 (25.0) 

Fixture Height (F) 0.0 (0.0) 

Z Lower Guide (L) 1.0 (25.0) 

Z Upper Guide (U) 1.1 (27.94) 

Guide Diameter (d) 0.5 (12.5) 

x1 -0.7 (-17.5) 

x2 3.1 (78.0) 

y1 -0.7 (-17.5) 

y2 2.8 (70.0) 

Work Offset G54  



 

Copyright @2014 Delcam Ltd  User Guide 3-5  

 

The fields in the Setup dialog have the following meanings: 

Part Height (H): The measured height of the part. 

Fixture Height (F): There are cases where the part may be elevated from 
the table. Insert difference between table and part bottom, this will be 
especially important for taper cutting. 

Z Lower Guide (L): Distance between the machine table and top of the 
lower guide representing the distance from the top of the table to lower 
guide.   

Z Upper Guide (U): The distance from the table to the bottom of the upper 
guide, i.e. the position for upper head, measured from top of table to bottom 
of the upper guide.  

Guide diameter (d): This x value is used to set the size of the guides when 
viewed in PartMaker Simulation. 

Boundaries (x1, y1, x2, y2): Describe the size of material you will be 
working with. 

Work Offset: Set this if your machine requires a work offset. 

Wire:  Select the diameter of wire you are going to use.  The wires available 
in the Setup dialog correspond to those that currently exist in the Tool 
Database. 

3 Click <Apply>. 

4 Click the <Close> box in the lower-right corner of the dialog to return to the 
Face Window. 

5 Click anywhere in the Face Window to make sure it is active. 
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View the Tool Information 
The Tools Database allows you to keep track of your current wire inventory. 
PartMaker uses geometric and cutting characteristics saved with each wire in 
the database for automatic cutting condition creation and automatic cycle time 
calculation. 

You can view the wires used for EDM_DEMO in the Tools dialog by choosing 
Tools from the ToolMinder menu. The Tool ID specifies the ID number of the 
currently selected wire in PartMaker’s Tool Database.  

 Note: The wires used in this chapter are for the tutorial only. As you begin 
to use PartMaker, you will add wires to the tools database. 

 
See Chapter 2 for more information using the Tools Database in PartMaker EDM.  
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Select a Material for the Part 
PartMaker has a materials database from which you can select a variety of 
material types compatible with various wire types and diameters. A material 
database allows you to store your shop’s accumulated materials data. PartMaker 
uses this data for the automatic calculation of cycles and cutting technologies. 

You can view information about the material used to create the EDM_DEMO part by 
choosing Material from the ToolMinder menu. 

 

 Note: When exiting a dialog, the Face Window loses focus and its title bar 
becomes grey. You may find a number of menu commands being disabled 
(gray) if a front window is not active (not in focus). To make sure the Face 
Window is the active window, click its title bar.  

See Chapter 2 for more information using the Material Database in PartMaker EDM.  
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View the Cycle Information 
PartMaker lets you combine a series of roughing and finishing operations into a 
single entity called a cycle. The Cycle information you create is saved in a Cycles 
Database for easy retrieval; reusing cycle information is as easy as opening a 
cycles file from the cycle’s database.  

You can view the cycles by choosing Cycles from the ToolMinder menu. 

 
See Chapter 2 for more information using the Cycles Database in PartMaker 
EDM. 
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Setting Defaults 
In this section, you’ll set the Defaults dialog for your part. Since the tutorial is 
designed for a part using the inch mode, you must be sure that PartMaker is in the 
correct mode.  To do so: 

1 Choose <Preferences> from the View menu to display the Preferences 
dialog 

2 Click the <Inch> button if it isn’t already selected 

3 Click <OK> to close and save your changes. 

Default settings are used in the program generated for a part. These parameters 
are used for each new group (cycle) you create. You can change Process Parameters 
at any time in the Process Parameters dialog (Process Parameters command in 
the Job Optimizer menu); you can change Part Boundaries at any time in the 
Setup dialog (Setup command in the View menu). 

Select <Defaults> from the Job Optimizer menu to display the Defaults dialog. 

 
Z Lower Guide. Specifies the default distance between the top of the table and 
the lower guide.  

Z Upper Guide. Specifies the default distance between the top of the table and 
the upper guide.  

Guide Diameter. Specifies the default diameter of the guide in simulation.  

Wire Threading Time (min). Specifies the default wire threading time in 
minutes to be used in time calculations.  

Rapid Feed. Specifies the default rapid feed rate to be used in time 
calculations.  

Arc Tolerance.  Specifies the maximum distance between the arc and any line 
used to approximate this arc. Used in 4-axis jobs.  

Glue Stop: Distance From End Of Profile Element. Specifies the default glue 
stop point distance from the end point of the Profile Element.  
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Slug Removal in Simulation: User Defined Part Point. Specifies a point that 
belongs to the finished part. Any slug created during simulation that does not 
contain the User Defined Part Point would be removed.  

X. Specifies the horizontal coordinate of the User Defined Part Point.  

Y. Specifies the vertical coordinate of the User Defined Part Point. 

Safe Startup Move: 

Full Approach Move: Specifies that the length of the safe startup move 
equals to the length of the first move of the tool path.  

Programmable Length (S): Allows the user to specify the length of the 
safe startup move.  

 Tip: The default button in all PartMaker dialogs is the heavily-outlined 
button (<OK> or <Apply>, for example). You can use the default button 
by clicking it or by pressing the <Enter> key. 
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Create Geometry 
There are two methods of creating Geometry in PartMaker. You can either import 
Geometry from a CAD file or define Geometry using PartMaker's CAD mode. In 
this tutorial, geometry will be imported from an existing DXF. For more information 
on creating part geometry, please see the section titled Using Graphics Icons in 
PartMaker CAD Mode in Chapter 2 of this guide. 

Import Geometry from a CAD system via DXF file. 
To import geometry for EDM_DEMO, do the following: 

1 Click the CAD/CAM switch to go to CAD Mode  

2 Choose Import, DXF File from the File menu to display Import DXF File 
dialog. 

 
3 Locate and select edm_demo.dxf, then click <OK>. 

Your screen should appear as shown below: 
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Now that you have a drawing in the Face Window, take a few minutes to explore 
some of the basic features of PartMaker that you will be using. 

From the View menu, you have the following Zoom options available: 

 

 
Select Full View to expand the drawing to fill the screen. 

 
Select Previous View to return the screen display to the previous 
setting. 

 
Select Zoom In and use any mouse button to drag opposite corners of a 
rectangle that you want to magnify. 

 Select Zoom Out to shrink the drawing on the screen 

 Select Continuous Zoom to magnify the drawing at a steady rate. You 
can do this by pressing <Ctrl> and the <+> or <–> key 

 Select Continuous Pan to move the drawing to the left or right at a 
steady rate. You can do this by pressing  <Ctrl> and the directional 
keys. 

 
Select Zoom to Fit to create the smallest possible window that will 
contain all of the geometry, dimensions and notes in the current window. 

 
Select Zoom All to create the smallest possible window that will contain 
all of the geometry, dimensions, notes and the boundaries in the current 
window 

 
Select Show Axes to show the current X0 Z0 location. Select Hide Axes 
to turn them off again. 

 
Show and Hide Boundaries is used to show the boundaries of the 
rough stock being turned. 

Depending on your needs, any or all of these display options may be activated at 
any time during the drawing (CAD) or programming (CAM) process. 

Save Your Work 
1 Choose Save Job File As… from the File menu to display the Save Job File 

as: dialog.  

2 Enter the name EDM_DEMO in the space provided and click <Save>. 
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Creating the tutorial part in PartMaker CAM Mode 
Now that you have the geometry for TUTORIAL, you are ready to begin working in 
PartMaker CAM mode.  To do so, you must first be in CAM mode.  You are in CAM 
mode when the CAD/CAM switch in the lower left-hand corner of the screen appears 
as the one to the left. 

Before proceeding, your Face Window should appear as the one below, with your 
geometry appearing as a gray outline on the screen: 

 

Define Group 1 Profiles for Inside Contour 
The first operation in this tutorial is inside contour. 

1 Make sure you are in the CAM Mode 

2 Choose red from the color bar   

3 Choose New Profile Group to display the Profile Group Parameters dialog. 

 
4 Choose 2 Axis from the Strategy drop-down menu. 



 

3-14 PartMaker  Copyright @2014 Delcam Ltd 

 

5 Choose Contour from the Roughing Method drop-down menu. 

6 Choose Left from the Tool Position drop-down menu 

Alternate Pass Direction: When your part requires multiple passes for accuracy or 
finish you can define wire motion in two different ways. All passes start at the 
start point and burn to the end point. You may also select Alternate Pass 
Direction. Doing so will enable you to start at the start point and burn to the end 
point and then from there, burn back to the start point. This will save you time 
in cutting the wire and repositioning to the start point.  

7 Click the <Material Properties> button. Once you activate the Select 
Materials button it will take you to the Material Library. Browse through the 
library and select the material type and height you are going to machine. 

 
8 For this job select Steel 1.0 (25.00) and click <OK>. 

9 Choose 1 from the Number of Skim Cuts drop-down menu. 

10 Click the Cycle button to check the cycle database for all possible cycles that 
match your Profile Group criteria. You can click the <C> the see the Cycle 
that was selected.  

11 In the Group Name box, enter: Inside Contour 1. 

12 Once you are satisfied that your completed Profile Group Parameters 
dialog appears as shown below, click <Close>: 
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Create Profiles Using the Chain Geometry Icon 

1 Select the Chain Geometry icon on the left side of the Face Window. Click 
the cursor on the location marked by the arrow on the screen below. 

 

Approach and Escape 
When starting or ending a profile within the work piece, there is usually a drilled 
hole or other feature through which to thread the wire. PartMaker will 
automatically select the closest circle center to start or end the tool path. 

1 Click the Selection Icon and select any part of the tool path you just 
created.  

2 Click on the Approach and Escape button and the dialog as shown below 
will open: 
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3 Click the Find Closest Circle Center button to automatically start the tool 
path at the center of the closest circle drawn in the CAD mode. If you have 
not created a circle, but you know the coordinates of the circle, you can 
enter them by clicking the Define Point box and entering the X and Y 
Coordinates in the respective fields.  Once your completed Approach and 
Escape dialog appears as shown below, click <OK>. 

 

Approach and Escape with Tangent Arc 
In addition to the simple linear APPROACH / ESCAPE move, PartMaker provides 
the ability to add a small tangent arc to this move to eliminate any ‘witness’ 
marks that may be created by the contact of the wire to the finished profile. 

This TANGENT ARC definition is accessed through the JOB OPTIMIZER > 
DEFAULTS menu item, which opens the dialog shown below: 

 
In the lower right hand corner of this dialog are the parameters for the Circular 
Move In / Out utility. 

By checking this box, you instruct PartMaker to add a small arc move at any 
location where an approach / escape move contacts the finished profile. 

Note that the radius of this arc should be small enough that the wire will burn 
the entire arc material away and not leave a ‘slug’ to drop down into the lower 
guide. 

The arcs created by this utility will not be shown in verification, but will appear 
in the final output code. 
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Glue Stop 
1 Click the Profile Info Icon. 

2 Click the cursor on the location marked by the arrow on the screen below. 

 
3 Now the Profile info dialog will appear. Select the radio button for At a 

Distance From End of Profile Element. 
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Verify Tool Path 
1 Select the Verify Work Group Tool Path command from the Part 

Features menu. You will see a picture as below. 

 
2 Select the Hide Every Tool Path command from the Part Features menu.  
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Define Group 2 Profiles for Tapered Circle 
1 Choose green from the color bar such that green appears as the Sample 

Color. 

 
2 Choose New Profile Group from the Part Features menu to display the 

Profile Group Parameters dialog. 

3 Choose 2 Axis & Taper from the Strategy drop-down menu.  

4 Choose Contour from the Roughing Method drop-down menu. 

5 Choose Left from the Tool Position drop-down menu 

6 Choose 2 from the Number of Skim Cuts drop-down menu. 

 Note: The material has already been selected from creation of the 
previous part feature. 

7 Click the Cycle button to check the cycle database for all possible cycles that 
match your Profile Group criteria.  

8 In the Group Name box, title this process Tapered Circle. 

Your completed dialog should appear as shown below: 

 
Before clicking <Close> please take a moment to learn more about 2-axis taper 
cutting with PartMaker. 
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Taper Cutting 
Programmed Surface in the Profile Group Parameters dialog is the location 
of the geometry you have created. If you are creating a tapered cone as shown 
below, you will draw a circle. You must indicate whether that circle size 
corresponds with the geometry on the top of the part or on the bottom of the 
part. 

 
The last field in the Profile Group Parameters dialog is the Land Size. This is 
only used when you are cutting a taper and a land. A land is the result of a taper 
that does not continue through the height of the part. 

 



 

Copyright @2014 Delcam Ltd  User Guide 3-21  

 

Creating Tapered Profiles Using the Chain Geometry Icon and Profile Element 
Data 

1 Select the Chain Geometry icon on the left side of the Face Window.  

2 Click your cursor to chain the profile that you want to taper, as shown below:  

 
3 Select the Check Profile Info Dialog Icon from the left side of the window.  

4 Double click the question mark on the tool path you have just created.  

5 Complete the Profile Info dialog with the appropriate parameters for your 
taper. 

 Angle (A) - The angle of the taper. This could be positive or negative 
depending on the programmed surface.  

 Register Number – Allows a specific command to be added to a specific 
line of NC code.  

 Conical - Applies only to a circular arc. The center of the circular arc 
remains unchanged for the top and bottom profiles. 

 Cylindrical – Applies only to a circular move. 

 Linear – When two adjacent elements have a different angle, choosing a 
linear taper type will smooth the transition between them. 

 Glue Stop – Select Glue Stop if you would like to insert a stop at a 
specific place on the profile.  

6 Change the Taper Angle to 12 degrees and select <Apply to All> 
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7 Leave Glue Stop set to None.  

 
8 When your Profile Info dialog appears as shown above, click <OK>. 

 Note: There will be Profile Info for each individual segment of your tool 
path. When PartMaker first prompts you for the Profile Info it is a 
universal prompt, applying to the entire tool path. This will apply to all 
segments of the tool path. If you have different angles within the same 
tool path you will go back later and change the Profile Info where 
appropriate by using the Profile Info icon.  

Approach and Escape 
When starting or ending a profile within the work piece, there is usually a drilled 
hole or other feature through which to thread the wire. PartMaker will 
automatically select the closest circle center to start or end the tool path. 

1 Click the Selection Icon 

2 Double click on any part of the tool path you just created.  You will see the 
Approach and Escape dialog open as shown below: 
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3 Click the Find Closest Circle Center button to automatically start the tool 
path at the center of the closest circle drawn in the CAD mode. If you have 
not created a circle, but you know the coordinates of the circle, you can 
enter them by clicking the Define Point box and entering the X and Y 
Coordinates in the respective fields.  Once your completed Approach and 
Escape dialog appears as shown below, click <OK>. 

 

Verify Tool Path 
1 Select the Verify Work Group Tool Path command from the Part 

Features menu. You will see a picture as below.  

 
2 Select the Hide Every Tool Path command from the Part Features menu.  
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Define Group 3 Profiles for Slot 
1 Choose Yellow from the color bar such that yellow appears as the Sample 

Color 

 
2 Choose New Profile Group from the Part Features menu to display the 

Profile Group Parameters dialog 

3 Choose 2-axis from the Strategy: drop-down menu 

4 Choose Contour from the Roughing Method drop-down menu 

5 Choose Left from the Tool Position drop-down menu 

6 Choose 1 from the Number of Skim Cuts drop-down menu 

7 Click the Cycle button to check the cycle database for all possible cycles that 
match your Profile Group criteria. 

8 In the Group Name box, call this process Inside Contour 2. 

Your completed dialog should appear as shown below: 

 
9 When your Profile Group Parameters appears as shown above, click Close. 
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Create Profiles Using the Chain Geometry Icon 
1 Select the Chain Geometry Icon on the left hand side of the Face Window. 

Click the cursor on the location marked by the arrow. 

 
2 There will also be an approach and escape move similar to the first profile 

created. To do so  

a Click the Selection Icon 

b Double click on any part of the tool path you just created.  You will see 
the Approach and Escape dialog open. Under Approach Point. 

c Click the Find Closest Circle Center button. 

d Once your completed Approach and Escape dialog appears as shown 
below, click <OK>: 
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Glue Stop 
1 Click the Profile Info Icon. 

2 Click the cursor on the location marked by the arrow on the screen below. 

 
3 Now the Profile info dialog will appear. Select the radio button for “At a 

Distance From End of Profile Element” 
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Verify Tool Path 
1 Select the Verify Work Group Tool Path command from the Part 

Features menu. You will see a picture as below. 

 
2 Select the Hide Every Tool Path command from the Part Features menu.  
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Define Group 4 Profiles for Outside Contours 
1 Choose purple from the color bar such that purple appears as the Sample 

Color 

 
2 Choose New Profile Group from the Part Features menu to display the 

Profile Group Parameters dialog 

3 Choose 2-axis from the Strategy: drop-down menu 

4 Choose Contour from the Roughing Method drop-down menu 

5 Choose Left from the Tool Position drop-down menu 

6 Choose 0 from the Number of Skim Cuts drop-down menu 

7 Click the Cycle button to check the cycle database for all possible cycles that 
match your Profile Group criteria.  

8 In the Group Name box enter Outside Radius. 

Your completed dialog should appear as shown below: 
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Create Profiles Using the Define Profile Icon 
Using the Define Profile icon and a Snap Mode, you can define a profile by 
connecting points defined by X, Y coordinates, polar coordinates, a point on an 
arc or circle, a screen location, a grid location, a circle center location, the 
closest intersection and endpoint of a line, or a midpoint of a line. 

1 Select the Define Profile icon on the left hand side of the Face Window. 
The snap modes will appear at the top of the screen.  

2 Select the Closest Intersection snap mode and then click the cursor on the 
locations marked by points 1 and 2. 

 
3 Once again, select the Define Profile icon on the left hand side of the Face 

Window. The snap modes will appear at the top of the screen. Select the 
closest intersection snap mode and click on the locations marked by 3 and 4. 
After doing so, select the Define Profile icon again to select the next 
corner.  

4 Repeat these steps for locations 5 and 6, and 7 and 8.   
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Leads 
After selecting all four corners open the profile group by double clicking on the 
Outside Radius process on the right side of the CAM screen then select the 
Leads button.  

 
1 Select Leads to .100 and the Angle to 90. 

 
2 Select <OK>  



 

Copyright @2014 Delcam Ltd  User Guide 3-31  

 

Verify Tool Path 
1 Select the Verify Work Group Tool Path command from the Part 

Features menu. You will see a picture as below.  

 
2 Select the Hide Every Tool Path command from the Part Features menu.  
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Generate a Process Table 
A process table shows you all of the processes for a part. Before generating a 
process table, you can choose to reorder processes to do all roughing operations 
first, and to cut wire automatically. 

When PartMaker generates a Process Table, all cutting conditions such as 
feedrate burn time are calculated automatically based on the cycles and material 
information.  

1 Choose Generate Process Table from the Job Optimizer menu to display 
the Process Table Options dialog.  

2 Turn on the first check box in the dialog.  The dialog box should appear as 
shown below: 

 
3 Click <OK> to display the Process Table window.  

 

 Note: Since we selected Reorder Process, Do Roughing First, you will 
see all of the roughing operations in sequence. Cut Wire Automatically 
was also checked so PartMaker will insert wire cuts after each roughing 
operation and in between different finish profiles. 
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Modify the Process Parameters 
Process 1 is a roughing process for the ID contour in Edm_demo.jbe.  In this 
section, you’ll change the cutting settings, feed rate, and other parameters used 
for this process. 

1 Click anywhere on the first process line in the process table window. 

A colored rectangle highlights the entire line. 

 

 Note: Colored triangles appear on the left side of the process table window. 
To move a selected process in the table, click a triangle—it will become 
the new location for the selected process. If you make a mistake when 
moving a process in the table, choose Undo from the Edit menu to move 
it back to its original position. 

2 Choose Process Parameters from the Job Optimizer menu to display the 
Process Parameters dialog. 

 
3 The power field is used to indicate the cutting setting on your machine. This 

will vary from one machine manufacturer to another.  

4 The offset field identifies the distance from the wire to the part for each 
process. 

5 The feed rate is the distance the wire will travel in a certain time.  

6 The Cut Wire option is used to identify a process where you will need to cut 
the wire before moving to the next process and rethreading.  

7 Remove Slug is used to identify stop points in the program where the 
operator would remove the slug piece before a finishing process can occur.  

8 Click <OK> to return to the Process Table window. 
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Simulate the Process 
Once you are satisfied with the appearance of your Process Table you can simulate 
cutting. 

1 From the Process Table, click the Simulate in the lower left hand corner of 
the Process Table or just press the <Space Bar>  

2 When the simulation Window appears, press the <Space Bar> or choose 
Simulation from the Solids menu to initiate 3D simulation.  Your completed 
part should appear as shown below: 
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Generate an NC Program 
1 Choose Post Config File = ? from the Job Optimizer menu to display the Open 

Post Configuration File dialog.  

2 Select the EDM_DEMO.pst postprocessor, then click <Open>. 

 

 Tip: If you use the same .PST file all the time, make sure it is the only one 
under the Pm-edm folder and it will be loaded automatically when you open 
the software.  

3 Choose Generate NC Program from the Job Optimizer menu to display 
the Save NC Program dialog. When you generate an NC Program for the 
first time during a programming session the Post Options dialog is displayed 
before the Save NC Program dialog. 

 
4 Choose the Post Options you prefer. If you leave Block Increment at zero 

there will be no sequence numbers in your part program. 
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5 Click <OK> to display the Save NC Program dialog. 

 
6 Enter the name TUTORIAL.TXT for the NC program, then click <Save> to 

generate the NC program 

Your completed NC program will be display below: 

 
 

You have completed all of the steps necessary to program your Wire EDM.  
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Chapter 4: PartMaker® Simulation 
Introduction 

PartMaker Versions 5.0 and higher come standard with an integrated 3D solid 
modeling process simulation and verification module.  The purpose of simulation is 
to let you visualize all the processes as ordered on PartMaker’s Process Table. You 
should run Simulation after the Process Table is arranged to your liking. 

PartMaker’s integrated process simulation module allows you to: 

 Simulate all machining processes as they appear on the Process Table 

 Observe the results of any process reordering 

 Examine a solid model of the part through dynamic rotation and cross-
sectioning 

Using PartMaker Simulation 
PartMaker Simulation can be viewed at any point in the programming process.  You 
need not complete programming a part to see the results of your work. 

 Important! To launch PartMaker Simulation you must have a Process Table 
generated.  To generate the Process Table, choose Generate Process 
Table from the Job Optimizer menu.  It is not necessary to complete 
synchronization of simultaneous operations before launching PartMaker 
Simulation. 

Launching Simulation 
To launch PartMaker Simulation: 

Press the Simulation button in on the Main tool bar 

or 

Press the Simulation button in the lower left hand corner of the Process Table 

or 

Choose Simulation from the Simulation menu 

Upon launching simulation, you will see an uncut work piece and the machining 
table that has been defined. A newly launched simulation window is shown 
below: 
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Running Simulation 
Once you have launched PartMaker Simulation, to start machining: 

1 To start Simulation press the Start Simulation button.  

or 

Choose Start Simulation from the Simulation menu 

or 

Press the <Space Bar> on your keyboard 

2 Once simulation has started, you can suspend cutting be pressing the Pause 
or the <Esc> button on your keyboard.  

Below, is an example of suspending simulation in progress: 
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The Simulation Toolbar 
Many of the common functions used in PartMaker’s 3D simulation can be accessed 
via the Toolbar that appears at the top of the Simulation Window as shown here: 

 
Each icon on the Simulation Toolbar is explained below.  The features each of 
these icons enable will be explained in greater depth throughout this chapter. 

 

 
Starts the simulation 

 
Pauses the simulation 

 
Resets the simulation 

 
Shows the finished 3D model of the part 

 
Allows you to measure the finished part 

 
Allows you to take cross sectional views of the completed part 

 
Allows you to show a full view of a part after sectioning 

 
Allows you to manipulate the view of machined part 

 
Allows you to see the Simulation Options dialog 
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Simulation Features 
PartMaker Simulation has a number of process and part analysis features available 
both during and after process simulation is complete.   

These features are described here: some of these features are not available in 
PartMaker EDM.  

Reset 
At any point you can reset the simulation to the initial screen by choosing Reset 
from the Simulation menu.  Alternatively, if you have suspended Simulation by 
pressing <Esc>, you can press <Esc> again to reset the simulation. 

The Reset command is also accessible by clicking the right mouse button when 
viewing the finished part (see below). 

Show Finished Part 
By choosing the Show Finished Part command from the Simulation menu, you 
can see a 3D model of your programmed part.  You need not run the simulation 
prior to choosing Show Finished Part.  

When choosing Show Finished Part, the verified part alone will appear in the 
Simulation window as shown here: 

 

Save Finished Part As STL file 
This will save the finished part to an STL file format.  This can be then used again in 
PartMaker for Custom Stock or Surface Machining. 
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Compare Finished Part to Solid Model 
This will use the solid model specified in the Comparison Options Dialog to show 
a comparison of the part to the solid model. 

 

Comparison Options 
This will open the Comparison Options dialog.  This allows you to specify the 
comparison models as well as the over and undercut display colors. 

View Setting Features 
PartMaker Basic Simulation allows you to automatically set a variety of views when 
simulation has been halted by using the <Esc> key or when using the Show 
Finished Part command.  Various view orientations are available from the View 
sub-menu under the Solids menu. 

Default 
Choosing Default sets the view in the simulation window to the default view 
when Simulation was launched. 

Best Fit 
Choosing Best Fit sets the view in the simulation window to the best fit 
relative to the Simulation window as determined automatically by 
PartMaker. 

XY View 
Choosing the XY View command sets the view in the simulation window 
normal to the cross sectional plane formed by XY axes.  The axes along 
which the part is defined are constantly active in the lower left hand corner 
of the simulation window. 

YZ View 
Choosing the YZ View command sets the view in the simulation window 
normal to the cross sectional plane formed by YZ axes.  The axes along 
which the part is defined are constantly active in the lower left hand corner 
of the simulation window. 
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ZX View 
Choosing the ZX View command sets the view in the simulation window 
normal to the cross sectional plane formed by ZX axes.  The axes along 
which the part is defined are constantly active in the lower left hand corner 
of the simulation window. 

Isometric View 
Choosing the Isometric View command sets the view in the simulation 
window aligned to the X, Y and Z axes.  This view presents the part at a 45 
degree angle. 

Show Coordinate Axes 
Checking this selection on allows the user to the axes symbol in lower left 
hand corner of PartMaker Simulation Window. 

Show Finished part Origin 
This will hide or show the 3-D axis on the finished part. 

Show Coordinate axis 
This will hide or show the 3-D coordinate system axes in the lower left hand 
side of the simulation window. 

Background Color 
Allows the user to choose the background color of the simulation.  The 
background may be set to gradient by choosing different colors for the Top 
and Bottom Gradient Color respectively. 

Datum Color 
Sets the color of each axis of the datum, X, Y and Z respectively. 
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View Manipulation Features: Rotate, Move and Zoom 
PartMaker simulation allows you to manipulate the view of either the entire process 
simulation or the finished part (when using Show Finished Part).  When using 
PartMaker, one of these commands will be activated, as denoted by a check next to 
it under the Change View sub menu under the Simulation menu.   

Whenever the Rotate, Move or Zoom command is checked, it can be activated by 
holding down the left mouse key and moving your mouse.   

It is advisable to always leave the Rotate command checked as both Move and 
Zoom can always be accessed using keyboard shortcut keys or the mouse.  For 
example, if the Rotate command is checked under the Change View sub menu 
under the Simulation menu, Rotate can be activated by clicking the left mouse 
button and moving the mouse, Move can be activated by holding down the mouse’s 
scroll wheel and moving the mouse and Zoom can be activated by simply scrolling 
the mouse’s scroll wheel. 

PartMaker provides fully dynamic simulation such that the Rotate, Move and Zoom 
commands can be accessed at any time during simulation. 

Rotate 
This command allows you to dynamically rotate the entire process simulation 
within the simulation window.  When using Show Finished Part, Rotate 
allows you to dynamically rotate the solid model of the completed part.   

When Rotate is active, you can rotate the process simulation or finished part 
by clicking the left hand mouse button and dragging your mouse in the 
orientation you would like to see the view. 

Rotate may only be used when it is activated from the Solids menu.  You 
can activate Rotate by choosing it from the Solids menu.  Its activation is 
denoted by a check next to it under the Simulation window. 

Move 
This command allows you to dynamically move the entire process simulation 
around the simulation window.  When using Show Finished Part, Rotate 
allows you to dynamically rotate the solid model of the completed part.   

When Move is active, you can move the process simulation or finished part 
by clicking the left hand mouse button and dragging your mouse in the 
direction you want to move the view.   

You can move the view if Move is NOT active by holding down the <Ctrl> + 
<Arrow> keys on your keyboard, with arrows denoting the direction in 
which the view will move.  These are the same keys used when performing 
panning in PartMaker. 

Additionally, Move can always be activated using the mouse by holding 
down the mouse wheel (if your mouse is so equipped) and dragging your 
mouse in the direction you want to move the view. 

You can activate Move by choosing it from the Solids menu.  Its activation 
is denoted by a check next to it under the Simulation window. 

Zoom 
This command allows you to dynamically size the entire process simulation 
within the simulation window when it has been halted by using the <Esc> 
key.  When using Show Finished Part, Zoom allows you to dynamically 
size the solid model of the completed part.   

When Zoom is active, you can scale the process simulation or finished part 
by clicking the left hand mouse button and dragging it upward to increase 
the size of the part and dragging downward to decrease the size of the part.   
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You can scale the view if Scale is NOT active by pressing the <F4> key to 
decrease the size of the view or the <F5> key to increase the size of the 
view.  These are the same keys used when performing Continuous Zoom 
In or Zoom Out in PartMaker. 

Additionally, Scale can always be activated using the mouse by scrolling the 
mouse wheel (if your mouse is so equipped) upward to zoom in and 
downward to zoom out. 

Sectioning Features 
PartMaker simulation allows you to section the solid view to inspect the interior of 
the part. Various sectioning options by choosing Sectional View from the 
Simulation menu.  Choosing Sectional View opens the Section Finished Part 
dialog as shown below: 

 
1 Sectioning Plane – The Sectioning Plane section of this dialog allows you to 

determine the plane across which sectioning will occur normal to. The use 
can section a finished part normal to the XY, ZY and ZX plane. The axes 
along which the part is defined are constantly active in the lower left hand 
corner of the simulation window.  

2 Dynamic Sectioning – Checking this box enables dynamic section, or the 
ability to see the part being sectioned as you adjust the location of the 
sectional plane.  If Dynamic Sectioning is unchecked, , you will be able to see 
the result of your sectioning by clicking the <Preview> button or by exiting 
this dialog by clicking <OK> 

3 Plane Coordinate - This area of the dialog allows you to adjust the level of 
the sectioning plane. 

4  Reverse Direction - This allows you to reverse the direction of sectional 
plane shown. 
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Simulation Options 
You can manipulate the appearance of simulation by choosing Options from the 
Simulation menu or by clicking the right mouse button in the Simulation Window 
and choosing Options.   

PartMaker Simulation allows you to change the appearance of the view in the 
simulation window when simulation has been halted by using the <Esc> key or 
when using the Show Finished Part command.   

The Options dialog as it appears in Basic Simulation for PartMaker Turn-Mill is 
displayed below: 

 

Pause On  
Never: Specifies that simulation should never pause during simulation 

Every Process: Specifies that simulation should pause at the beginning of every 
process in the current Process Table 

Selected Process: Specifies that simulation should pause at the beginning of a 
selected process in the current Process Table 

Every Move: Specifies that simulation should pause before every tool move 

Glue stop: Specifies that simulation should pause every time a glue stop occurs 
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Display Control 
Time Delay (0...9): Specifies a time delay following every screen update for 
every tool motion 

Transparency of Stock/Part: Specifies how transparent the part and/or stock 
should appear. 0% means solid part, 100% means "fully transparent" part, i.e. 
an invisible part. 

Run in a Loop: Specifies that Simulation will run in a continuous loop 

Software Rendering: Specifies that Open GL software graphics libraries should 
be used instead of the hardware implementation of the Open GL drivers that are 
dependent on the actual Graphics Video card used in every computer. If you use 
a high performance AGP video card you may achieve a significant simulation 
speed improvement if you do not use Software Rendering 
Wireframe Display: Specifies that everything will be displayed using a wire 
frame representation instead of solid modeling 

Display Quality 
Coarse: Specifies that solids will be displayed using relatively large facets to 
assure the fastest simulation 

Medium: Specifies that solids will be displayed using medium size facets that will 
result in lesser simulation speed 

Fine: Specifies that solids will be displayed using very small size facets that will 
result in further decrease in simulation speed 

 

Colors and Textures 
Use Group Colors: Specifies that user-defined Group Colors will be used as cut 
colors. If this option is not checked a metallic gray color will be used as cut color 
for all tools 

Set Stock Color: Allows a user to choose the color of initial stock using a 
Windows standard dialog. 

Set Stock Texture: Opens the Texture Dialog for various texture options for 
the stock. 



 

Copyright @2014 Delcam Ltd  User Guide A-1  

 

Appendix A: Solids Import Tutorial for 
WireEDM 
Introduction 

This tutorial will teach you how to import 3D solid models into PartMaker/WireEDM 
for the purpose of extracting tool path geometry from them. 

PartMaker Version 5.3.8 and higher features the ability to directly import 3D solid 
models in Parasolid™ transmit format (.X_T and .X_B files), as well as native 
SolidWorks™ format (.SLDPRT files) and Autodesk Inventor™ (.IPT files). Once 
imported, it is then possible to inspect the solid model and extract geometry from 
the solid model by taking sections, projected views and ‘unwrapped’ geometry. It is 
also possible to interrogate the model in order to obtain various plane angles, plane 
offsets, hole diameters, hole depths, etc.  

The ability to import solids is available with every PartMaker product, namely, 
PartMaker/Turn, PartMaker/Mill, PartMaker/Turn-Mill, PartMaker/SwissCAM and 
PartMaker/WireEDM.  The steps presented in this tutorial are carried out in 
PartMaker/WireEDM but can be used in any PartMaker application. 

Sequence of Steps for importing solid models and geometry 
extraction 

The steps outlined below describe the sequence in which you should approach in 
importing and manipulating solid models within PartMaker.  This tutorial follows the 
sequence of steps below in importing and geometry extraction of a typical solid 
model. 

1 Import Solid Model : Read solid part file into Partmaker.  

2 Origin Axis Transformations: Perform all the necessary origin and axis 
transformations to the part so that it is aligned correctly. 

3 Geometry Transfer and Part Interrogation: Transfer geometry to the 
face window either by copying and pasting or doing a direct transfer. At the 
same time, view geometric information about the part by double clicking on 
various topological features like faces, edges and vertices. 
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Importing a Solid Model 
1 Select the Import icon and select the X_T Solid Model. The following file 

formats can currently be imported into PartMaker: 

 
2 Choose the edm_demo.X_T file and click <Open> 

 
3 When the file is read into PartMaker, it will appear in a separate Solids 

window. It can then be visually inspected by rotation, translation and 
scaling. There is a separate tool bar at the bottom of the Solids window for 
editing and manipulating the imported solid. 
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Origin/Axis Transformations 
The part has to be correctly aligned according to PartMaker alignment conventions 
for accurate and meaningful geometry extraction. This can be accomplished by 
selecting the Edit Coordinate button. You will then be able to: 

 Change the origin by setting it at a new position. 

 Re-align the coordinate axes in order to change the orientation of the 
part.  

 Rotate the part about an axis through an angle in order to simplify 
geometry extraction. 

 
However, in this case, since the part is aligned correctly along the Z-axis, we will 
not have to carry out any transformation operations on the part. Please refer to the 
section explaining this dialog at the end of the tutorial for more information. 

Geometry Transfer and Part Interrogation 
First make sure that PartMaker is in Overlapping Windows Mode. This makes it 
easier for geometry transfer by keeping both the Solids import window as well as 
the face window visible simultaneously. To do so, choose Preferences from the 
View Menu. Enable Overlapping Windows. Then choose Arrange Windows 
from the Window Menu. You will observe tiling of the face window and the Solids 
import window. Next, we will program the job file for the part by extracting 
geometry from the solid model. 

Double click on the face as shown.  
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This will bring up the Surface Info Dialog, displaying various face features like 
angles with the XY, XZ and YZ planes as well as the z, y and z offsets from the 
origin. Check the box for “Set Boundaries” and “Set Face Plane as Selected” 
and click the “Transfer Geometry” button. This button transfers the face geometry 
into the XY window. 

 
You can now program the machining operations for the part as discussed in the 
WireEDM tutorial. 
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Edit Coordinate System Dialog 
In order to extract geometry correctly, the part has to be oriented along a specific 
axis with the origin at a particular point. Often the imported part needs to be 
transformed manually in order to orient it in the proper manner. The following kinds 
of transformations are possible: 

 Changing the origin by setting it at a new position. 

 Re-aligning the coordinate axes in order to change the orientation of 
the part.  

 Rotating the part about an axis through an angle in order to simplify 
geometry extraction. 

In order to transform a part, choose Edit Coordinate System from the Solids Menu.  
The following dialog box will be displayed.  
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Set New Part Origin 

Set Part Origin checkbox: Allows you to select the method of choosing a new 
origin: 

 Vertex: Sets the new origin at the selected vertex of the part. 

 Arc/Circle Center : Sets the new origin at the center of the selected arc 
or circle. 

 Face Center: Sets the new origin at the center of the selected face. The 
face can be a sphere, torus or a planar face. 

 Edge MidPoint: Sets the new origin at the midpoint of the selected 
edge. The edge has to be a straight line. 

X. The x coordinate of the new origin 

Y. The y coordinate of the new origin. 

Z. The z coordinate of the new origin. 

 These values can be manually set or automatically filled when a selection 
is made using one of the methods of selection discussed earlier. 

<Set> button: Sets the new origin at the point described by the new 
coordinates. 

Align Axis to selected Edge or Surface 

Align Axis checkbox: Allows you to align the selected edge or surface from the 
solid model with the Part Coordinate System axis (X Axis, Y Axis or Z Axis) 
selected in this area of the dialog. 

<Align> button: Aligns the edge or surface selected in the solid model with the 
selected axis of the Part Coordinate System. 

Transform Coordinate System 

From. Allows you to select the initial axis orientation to be transformed from. 

To. Allows you to select the final axis orientation to be transformed to. 

<Transform> button: Sets the selections for transforming the axis orientation 
from 'From' to 'To'. 

Rotate Part 

X Axis: If selected, rotates the part about the X axis 

Y Axis: If selected, rotates the part about the Y axis 

Z Axis: If selected, rotates the part about the Z axis 

Angle: Angle about which to rotate the part in degrees. Negative values are 
allowed. 

<Rotate> button: Rotates the part about one of the above selected axes. 

Buttons 

<Clear All Transforms>: Click to clear all the transforms performed on the 
part since it was imported into the job file and return it back to its original 
coordinate system. 

<Undo>: Click to reverse the last origin change, axis transform, or part rotation 
performed on the part. 

<Close>: Click to close the dialog. 
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